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ЦЕЛЬ РАБОТЫ 
Целью курсового проекта является изучение принципов и приобре-

тение практических навыков аналогового проектирования полузаказной 
интегральной схемы с использованием базового матричного кристалла 
(БМК). Кроме того, студенты получают представление о средах схемотех-
нического и топологического проектирования. 
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1. ВВЕДЕНИЕ 
Базовым матричным кристаллом называется часть полупроводнико-

вой пластины с регулярным расположением сформированных в нём эле-
ментов соединённых и (или) несоединённых между собой, используемая 
для создания интегральных микросхем путем установления металлических 
межэлементных соединений.  

Базовые матричные кристаллы (БМК) являются универсальными 
кристаллами-заготовками, расположенными на полупроводниковой пла-
стине. Такие кристаллы называют базовыми, поскольку все фотошаблоны, 
за исключением слоев коммутации, для их изготовления являются посто-
янными и не зависят от реализуемой схемы. Простейшие элементы распо-
лагаются на кристалле в узлах прямоугольной матрицы, поэтому его назы-
вают матричным. Изготовление конкретной БИС на БМК осуществляется 
путем коммутации его элементов с помощью однослойной или многослой-
ной разводки. 
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2. ЗАДАНИЕ НА КУРСОВОЙ ПРОЕКТ 
Эти и другие материалы к курсовому проекту можно взять на интер-

нет-сайте этого проекта [ http://lsamb.narod.ru/students/kurs1.html ]. 
Данную работу рекомендуется выполнять с помощью специализиро-

ванных САПР: моделирование в программах типа Spice (P-Spice, OrCAD, 
Tanner T-Spice и т. п.), разводку в топологическом редакторе (Tanner L-
Edit, IC Studio и т. п.). 

Для работы предлагаются схемы различных современных аналого-
вых устройств: операционных усилителей, стабилизаторов напряжения, 
полосовых усилителей мощности, компараторов напряжения и др., – взя-
тых из справочников или интернет-сайтов производителей микросхем. 

От преподавателя нужно получить электрическую схему и парамет-
ры пассивных элементов. Кроме того, должны быть выданы электронная 
версия методических указаний, файл MOD с моделями активных элемен-
тов кристалла, файл GDS/TDB с топологией кристалла. 

Анализ схемы и подготовка рабочего файла для Spice 
Полученную электрическую схему устройства следует проанализи-

ровать, определить её структуру и принципы работы. Далее в графическом 
схемном редакторе следует сформировать электрическую схему и подклю-
чить файл с моделями активных элементов: мощных и маломощных бипо-
лярных транзисторов, диодов, МОП-транзисторов с управляющим затво-
ром, стабилитронов и др. 

В составе кристалла нет большого количества диодов, а МОП с 
управляющим затвором нет вовсе: 
− ДИОД: при моделировании следует заменить маломощным биполяр-

ным транзистором в диодном включении;  
− МОП транзистор с управляющим затвором: при моделировании ис-

пользовать его собственную модель (есть в файле с моделями). 
При вводе схемы в программу следует быть очень внимательным: 

случаи некорректной работы схемы часто связаны именно с неправильным 
кодированием. 

Моделирование схемы 
Следующий этап – моделирование схемы в программе. Требуется ра-

зобраться в принципе работы и режимах работы схемы и продемонстриро-
вать её работоспособность с учётом того, что свойства и параметры прибо-
ров из БМК отличаются от свойств и параметров приборов исходной схе-
мы. Это означает, что можно не достичь необходимых значений конкрет-
ных параметров, например, коэффициента усиления в усилителе, но долж-
но наблюдаться повторение формы сигнала достаточной амплитуды. 

http://lsamb.narod.ru/students/kurs1.html
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Моделирование устройства нужно проводить в соответствии со схе-
мой подключения (обычно типовой, приводимой в описании микросхемы). 
В тех САПР, где это возможно, устройство можно реализовать в виде бло-
ка (элемента иерархии), внедряемого в схему подключения. Следует также 
подготовить минимальный набор входных тестовых сигналов, демонстри-
рующих работоспособность схемы. 

Рассмотрим более подробно структуру и принцип действия операци-
онного усилителя (ОУ). 

Операционный усилитель – это дифференциальный усилитель об-
ратного тока с очень большим коэффициентом усиления и несимметрич-
ным выходом. Условное обозначение для всех типов дифференциальных 
усилителей изображено на Рис. 1. Входы обозначаются (+) и (–) и работа-
ют следующим образом: выходной сигнал изменяется в положительном 
направлении, когда потенциал на входе (+) становится более положитель-
ным, чем на входе (–) и наоборот. Эти входы называются инвертирующий 
и неинвертирующий соответственно. Операционные усилители обладают 
колоссальным коэффициентом усиления по напряжению и никогда не ис-
пользуются без обратной связи. Отрицательная обратная связь – это про-
цесс передачи выходного сигнала на вход, при котором гасится часть 
входного сигнала. При этом несколько уменьшается коэффициент усиле-
ния, но улучшаются другие параметры схемы (устраняется нелинейность и 
искажения, поведение схемы в целом делается более предсказуемым). Чем 
глубже отрицательная обратная связь, тем больше внешние характеристи-
ки усилителя зависят от параметров самой схемы обратной связи. 

 
Рис. 1. Условное схемное обозначение ОУ 

Принципы работы операционного усилителя: 1) выход ОУ стремится 
к тому, чтобы разность напряжений между его входами была равна нулю. 
Значение выхода через обратную связь передаётся на вход, и результи-
рующее устойчивое состояние характеризуется нулевой разностью потен-
циалов входов самого ОУ (если это возможно).; 2) входы ОУ ток не по-
требляют.  

Рассмотрим инвертирующий и неинвертирующий операционный 
усилитель. Схема включения инвертирующего усилителя изображена на 
Рис. 2. Проанализируем схему: 

Потенциал точки B равен потенциалу земли, следовательно, согласно 
правилу 1, потенциал точки А также равен потенциалу земли. Это означа-
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ет, что: а) падение напряжения на резисторе R2 равно Uвых; б) падение на-
пряжения на резисторе R1 равно Uвх.. Далее, воспользовавшись правилом 1, 
получим, что , или коэффициент усиления по напряжению 
= . Пусть на вход подан 1В, резистор  имеет номинал 
10 кОм, резистор  – 100 кОм. Теперь представим себе, что напряжение 
на выходе стало 0 В. Резисторы  и  образуют делитель напряжения, с 
помощью которого потенциал инвертирующего входа поддерживается 
равным 0,91 В. ОУ фиксирует рассогласование по входам и напряжение на 
его выходе начинает уменьшаться. Изменение будет происходить до тех 
пор, пока выходное напряжение не достигнет значения -10 В. В этот мо-
мент потенциалы входов станут одинаковыми и равными потенциалу зем-
ли. Аналогично, если напряжение на выходе начнет уменьшаться и дальше 
и станет более отрицательным, чем –10 В, то потенциал на инвертирую-
щем входе станет ниже потенциала земли и в результате выходное напря-
жение начнет расти. Недостатком этой схемы является малое входное со-
противление, особенно для усилителей с большим коэффициентом усиле-
ния по напряжению, в которых резистор  как правило бывает неболь-
шим. Этот недостаток устраняет схема с неинвертирующим усилителем, 
изображенная на Рис. 3. . Напряжение  снимается с делителя на-
пряжения: . Если 

12 // RURU вхвых −=

12 // RRUU вхвых −= 1R

2R

1R 2R

1R

A вхU U= AU

1 1 2/( )A выхU U R R R= + A вхU U= , то коэффициент усиления ста-
нет равным . Входное сопротивление такого неинверти-
рующего усилителя обычно превышает 10

2/ 1 /вых вхU U R R= + 1
8 Ом; выходное, как и в преды-

дущем случае, равно долям Ома. 

 

 

Рис. 2. Инвертирующий ОУ Рис. 3. Неинвертирующий ОУ 

Если источник входного сигнала связан по переменному току, то 
должен быть обеспечен путь к земле для (очень малых) входных токов (см. 
Рис. 4). 
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Рис. 4. Неинвертирующий ОУ для переменного тока 

Рассмотрим расчёт схемы неинвертирующего ОУ в режиме пере-
менного тока. На первом шаге необходимо скорректировать смещение ну-
ля операционного усилителя с помощью подстройки внутреннего резисто-
ра. После этого можно подавать входные сигналы. На Рис. 5 показан пере-
менный входной сигнал (разность напряжений на инвертирующем и неин-
вертирующем входах) амплитудой 8 мВ; типичный выходной сигнал изо-
бражён на Рис. 6. Амплитуда выходного сигнала в данном случае 1,8 В, 
что даёт коэффициент усиления 225. Моделирование этой характеристики 
проводилось в режиме временного анализа. Другой важной характеристи-
кой ОУ является амплитудо-частотная характеристика (Рис. 7), которая 
должна моделироваться в режиме переменных токов. И наконец, необхо-
димо протестировать импульсный отклик схемы (Рис. 8). 

Для стабилизатора напряжения необходимо в статическом режиме 
расчёта получить график, показывающий линейное увеличение выходного 
напряжения при линейном увеличении входного до номинального, а при 
достижении номинального входного напряжения, постоянное выходное, 
как на Рис. 9. 

Рис. 5. Переменный входной сигнал 
 неинвертирующего ОУ 

Рис. 6. Переменный выходной сигнал 
 неинвертирующего ОУ 
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Рис. 7. Амплитудо-частотная характе-
ристика неинвертирующего ОУ 

Рис. 8. Импульсная реакция  
неинвертирующего ОУ 

 

Рис. 9. Результат моделирования стати-
ческой характеристики инвертирующе-

го стабилизатора напряжения 

Рис. 10. Результат моделирования вре-
менной характеристики компаратора 

Для компаратора необходимо во временном режиме расчёта полу-
чить график, показывающий переброс схемы из одного стабильного со-
стояния в другое при изменении знака дифференциального входного сиг-
нала (разности входных сигналов) и при наличии разрешающего уровня 
входа OE – «Разрешение выхода», как на Рис. 11. 

Работоспособность схемы необходимо продемонстрировать препо-
давателю на компьютере. 

Разведение на кристалле 
Разведение схемы на аналоговом кристалле – нетривиальная задача, 

которая не поддаётся полной формализации. Рекомендуется логически 
разбить схему на фрагменты и развести каждый из них отдельно. Схема, 
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предлагаемая для этого курсового проекта, требует от четверти от полови-
ны площади кристалла. 

Критический параметр для разведения – минимальный размер. Ши-
рина металлической дорожки – от 5 до 10 мкм (по выбору). 

Необходимо составить таблицу распределения элементов схемы по 
элементам кристалла. БМК содержит несколько разных типов транзисто-
ров (pnp и npn, маломощные и мощные), резисторы и конденсаторы раз-
личных номиналов. 

Для реализации выходных транзисторов схемы и составных транзи-
сторов нужно брать мощные транзисторы кристалла, для всех остальных – 
маломощные. Примечание: транзисторы составного транзистора следует 
на топологии располагать рядом. 

Для реализации на кристалле диодов и МОПТ с упр. затвором: 
− ДИОД: следует реализовать в виде маломощного биполярного тран-

зистора в диодном включении; 
− МОП транзистор с управляющим затвором: следует представить би-

полярным транзистором с такой же структурой p/n-областей (см. 
элементы кристалла), установив в нужных местах металлические за-
творы. 
Необходимые номиналы резисторов и конденсаторов необходимо 

набирать в виде последовательной и/или параллельной комбинации из 
числа доступных на кристалле. Например, для получения резистора в 
5 кОм нужно соединить последовательно резисторы RE (4,6 кОм) и RB 
(440 Ом). Допускается погрешность не более 10%. 

Выводы схемы следует подвести к выходным контактным площад-
кам, а сами площадки металлизировать. 

Разведение схемы на кристалле должно производиться с помощью 
топологического редактора. Следует использовать достаточно яркие цвета 
для рисования соединительных линий (отсутствующие в исходном файле). 
Лист разводки должен содержать проставленные номера точек (дорожек) и 
приборов (транзисторов, резисторов, диодов), соответствующие электри-
ческой схеме. 

По поводу резисторов 
Некоторые резисторы кристалла составные – объединённые после-

довательно три резистора разного номинала. Следует помнить, что невоз-
можно использовать их крайние секции, не используя среднюю – иначе 
получится нежелательная связь невысокого сопротивления. 

По поводу конденсаторов 
Используются конденсаторы на основе МОП-структуры (структура 

приведена в части 4). Диэлектриком здесь служит обычный оксид кремния, 
покрывающий микросхему. Нижняя обкладка изготавливается в виде об-
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ласти инверсной проводимости. Верхняя обкладка формируется в виде ме-
таллического слоя в общем цикле нанесения металла на кристалл. Все три 
имеющихся контакта конденсатора связаны с его нижней обкладкой. Для 
подключения такого конденсатора нужно подвести дорожки к контактам 
(первая обкладка), очертить границу второй обкладки, соблюдая расстоя-
ние до дорожек и контактов к первой обкладке.  

Ёмкость конденсатора можно менять, изменяя площадь верхней ме-
таллической обкладки, в пределах от минимальной до полной. 

3. АНАЛОГОВЫЙ БМК «ФАРХАД–2» 

Описание БМК 
Аналоговый базовый матричный кристалл (БМК) «Фархад–2» вы-

полнен по биполярной технологии с изоляцией элементов обратносмещён-
ным p-n-переходом и предназначен для разработки радиотелевизионных 
полузаказных аналоговых ИС. 

Топологические особенности конструкции элементов базового кри-
сталла заключаются в том, что он имеет несколько увеличенную, чем это 
необходимо для обеспечения заданных электрических характеристик, 
площадь и дополнительные контактные окна, что создаёт большие удобст-
ва для разводки топологии схемы на кристалле за счёт прокладки межсо-
единительной металлизации по площади транзистора между электродами и 
контактными окнами. Для разработки топологии схемы данная технология 
позволяет использовать один уровень металлизации. 

В целях облегчения разводки в местах, где наиболее вероятны пере-
сечения трасс межсоединительной металлизации, расположены «подны-
ры» – низкоомные области как в кармане (42 шт.), так и в подложке 
(8 шт.). Диффузионные резисторы выполняются в базовом слое и имеют 
абсолютный разброс параметров ±25% при относительном согласовании 
±2%. Конфигурация их выбрана так, что подключение металлизации к 
контактному окну возможно с любой стороны, а между контактными ок-
нами есть возможность провести хотя бы одну трассу металлизации. 

БМК имеет размер 2,3 * 3,0 мм и 24 контактные площадки размером 
140 * 140 мкм. На кристалле расположено 140 активных элементов, из них 
80 маломощных npn-транзисторов (TNB); 4 маломощных npn-транзистора, 
которые можно использовать как эмиттерные повторители; 8 буферных 
npn-транзисторов (TNE); 8 диодов; 36 маломощных pnp-транзисторов 
(TPA); 4 буферных pnp-транзистора (TPC). Кроме того, на кристалле рас-
положены пассивные элементы: 104 диффузионных резистора сопротивле-
нием от 100 Ом до 16 кОм, 24 пинч-резистора сопротивлением 24 кОм и 
53 кОм, 4 конденсатора ёмкостью 8 пФ, 50 коммутационных перемычек. 



 – 11 – 

Элементы БМК сгруппированы в два макрофрагмента, которые рас-
положены в центральной части кристалла и отделены друг от друга прохо-
дом для проведения межсоединительной металлизации, где расположены 
диффузионные перемычки и наборы резисторов. Резисторы расположены 
группами в одном кармане. Их конфигурация позволяет путём последова-
тельного и параллельного соединения получать сопротивление нужного 
номинала. В кармане имеются контакты для подключения шины положи-
тельного источника питания с тем, чтобы изолировать резисторы друг от 
друга. 

По периферии БМК между контактными площадками размещены 
транзисторы повышенной мощности, конденсаторы и пинч-резисторы. По 
периметру базового кристалла располагаются контакты для подключения 
шины отрицательного питания или «Земля» к подложке. 

Список и описание элементов БМК 

 
транзистор типа TNE – npn-

транзистор  
повышенной мощности: 

 
транзистор типа TPC – pnp-

транзистор  
повышенной мощности: 

 
транзистор типа TNB – npn-

транзистор 
малой мощности: 

 
транзистор типа TPA – pnp-

транзистор  
малой мощности: 

 
Изображение элемента Описание элемента 

 

Перемычка (подныр) ra, rb сопро-
тивлением 30–40 Ом 

 
резистор типа RA (100 Ом) 
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резистор типа RB (440 Ом), RC 
(1,2 кОм) и RE (4,6 кОм) 

 
резистор типа RD (2,4 кОм) 

резистор типа RF (5,8 кОм) 

 

резистор типа RG (16 кОм) 

 

резистор типа IR1 (24 кОм) 

 

 

резистор типа IR2 (53 кОм) 

 контактная площадка 

 конденсатор структуры МОП 
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Содержимое файла с моделями элементов 
*********************** *********************** 
*      .START Models for FARHAD sea of gates  * 
*********************** *********************** 
 
*  TNB - weak NPN bipolar 
.model  TNB  npn ( cje=0.7e-12  mje=0.5025  vje=0.881  cjc=1.45e-12 
                 + mjc=0.489  vjc=0.771  fc=0.9  tf=3.089e-10  tr=1.611e-10  
                 + bf=54.36  br=7.74  vaf=28.26  var=2.27  is=1.2e-15 
                 + ne=1.5  nc=2  nf=1  nr=1  re=4.55e-3  rc=13.6  ikf=61.68 
                 + ikr=8.45e-3  xti=1.694  xtb=3.363 ) 
*  TPA - weak PNP bipolar 
.model  TPA  pnp ( bf=67.3  br=1  cjc=4.613e-12  cje=2.003e-12  fc=0.9 
                 + ikf=0.102  ikr=3.234e-3  is=2.157e-14  mjc=0.3983 
                 + mje=0.5025  nc=2  ne=1.5  nf=1  nr=1  rc=83.77 
                 + re=1.39e-2  tf=1.086e-9  tr=4.149e-9  vaf=21.58 
                 + var=14.98  vjc=0.59  vje=0.775  xtb=2.749  xti=5.195 ) 

 
*  TNE; - power NPN bipolar 
.model  TNE  npn ( cje=0.85e-12  mje=0.553  vje=0.881  cjc=4.14e-12 
                 + mjc=0.49  vjc=0.771  fc=0.9  tf=0.089e-10  tr=1.611e-10 
                 + bf=54.36  br=10.84  var=28.26  vaf=2.27  is=4.8e-15 
                 + ne=1.5  nc=2  nf=1  nr=1  re=1.114e-3  rb=97  rc=5.9 
                 + ikf=17.62e-3  ikr=33.8e-3  xti=1.694  xtb=3.363 ) 
*  TPC - power PNP bipolar 
.model  TPC  pnp ( cje=3.992e-12  mje=0.5025 vje=0.575  cjc=7.285e-12 
                 + mjc=0.3983  vjc=0.59  fc=0.9  tf=1.086e-9  tr=4.149e-9 
                 + bf=67.3  br=1  vaf=21.58  var=14.98  is=4.299e-14 
                 + ne=1.5  nc=2  nf=1  nr=1  re=6.975e-3  rc=42.02 
                 + ikf=0.1604  ikr=6.447e-3  xti=5.195  xtb=2.749 ) 
                  
* NJF model (for FET) 
.model  J1   NJF ( vto=-1.562  beta=816.3u  lambda=8.83m  rs=31  rd=31  
                 + cgs=3.2p  cgd=2.2p  fc=0.5  pb=1  is=10f ) 
 
* Stabilitron model and Shottky 
.model  stab  D  ( is=520e-18  rs=15  n=1  xti=4.3  eg=1.15  cjo=800f  af=1  
                 + m=.3333 vj=.65  fc=.5  bv=7.2  ibv=2u  tt=300p  kf=6f )  
 
*********************** *********************** 
*     .END Models for FARHAD sea of gates     * 
*********************** *********************** 

4. ПРЕДСТАВЛЕНИЕ ОТЧЁТА 
На титульном листе нужно указать название исследуемой схемы. 
Отчёт должен содержать следующие части: 

− электрическая схема устройства, на которой подписаны номера эле-
ментов и номиналы пассивных компонентов + схема подключения; 

− описание принципов работы устройства и его параметров; 
− описание БМК и его элементов (см. часть 3) + таблица распределения 

элементов схемы по элементам кристалла; 
− расчёт занятой площади и коэффициента заполнения кристалла; 
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− модель схемы для Spice + модели элементов (см. часть 2.3); 
− графики, демонстрирующие работу схемы (см. часть 2.2); 
− заполненный лист разводки (см. часть 6), на котором подписаны но-

мера использованных приборов. 

5. КРАТКИЕ СВЕДЕНИЯ О ПРОГРАММЕ SPICE 
SPICE – программа моделирования электронных схем. В ней можно 

рассчитывать режимы схем по постоянному току, частотные, переходные и 
шумовые характеристики, анализировать влияние температуры. Исполь-
зуемые элементы схем: сопротивления, ёмкости, индуктивности, диоды, 
транзисторы различных типов, трансформаторы, независимые и управляе-
мые источники напряжения и тока. 

Различных программ типа SPICE много. Наиболее распространен-
ные: PSPICE для DOS, OrCAD, T-Spice (Tanner).  

Некоторые программы позволяют графический ввод схемы. В этом 
случае перевод графической информации в базовый текстовый формат 
производится внутренними средствами программы. 

Информация для программы SPICE задаётся в виде текстового файла 
определённого формата. Файл содержит описание схемы и тип выполняе-
мого анализа. Расширение входного файла в ОС Windows – .CIR или .SP. 
Выходная информация выводится, в простейшем случае, в два файла: пер-
вый содержит сообщения интерпретатора и значения рассчитываемых вы-
ходных переменных, имеет расширение .OUT; второй содержит данные 
для построения графиков, имеет расширение .DAT.  

Запуск программы (версия PSPICE для DOS) 
Запуск программы расчёта в комплексе PSPICE версия для DOS: 

нужно запустить файл PSPICE1.EXE. Программа запросит имя входного 
файла – ввести его, затем имя выходного файла – по умолчанию (нажатию 
клавиши ВВОД) имя сохранится таким же. После этого программа начнёт 
расчёт схемы. Если в процессе расчёта будут найдены ошибки, выдаётся 
звуковой сигнал через спикер и сообщение «Circuit has errors». В этом слу-
чае нужно обратиться к выходному файлу (*.OUT), в нём символом «-------
-------$» указано место ошибки и её описание. Все ошибки нужно испра-
вить. Если расчёт завершается успешно, выдаётся сообщение «Simulation 
completed successfully». В этом случае можно строить графики. Для запус-
ка программы построения графиков (PROBE) нужно запускать файл 
PROBE.EXE. Чтобы добавить графики, нужно выбрать пункт меню 
Add_Trace и ввести нужные выходные переменные через пробел. Чтобы 
выйти из программы PROBE, нужно выбрать пункт меню Exit. 
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Запуск программы (версия OrCAD для Windows) 
Запуск программы расчета в комплексе OrCad 9.2 версия для Win-

dows: нужно запустить программу PSpice в меню Пуск > … > Orcad 9.2. 
Затем создать .cir файл со схемой или открыть заранее созданный файл и 
запустить расчёт (команда меню Simulation > Run или кнопка «Run Simula-
tion» на левой вертикальной панели инструментов). После этого программа 
начнет расчёт схемы. Если в процессе расчёта будут найдены ошибки, то 
программа прервёт работу и автоматически откроется выходной файл 
(.out), куда будет выведен текст программы и ошибочные места указаны 
символом «--------------$». Внимание!!! Для устранения ошибок необходимо 
вернуться в .cir файл (команда меню Window > View Circuit File или кноп-
ка «View Circuit File» на левой вертикальной панели инструментов. После 
исправления всех ошибок следует перезапустить расчёт. По окончании 
расчёта для просмотра результатов необходимо выбрать пункт меню 
View > Show Simulation Results. Добавление в конец .cir файла перед опе-
ратором .END оператора .PROBE позволит автоматически открывать окно 
просмотра результатов. 

Для вывода графиков нужно, находясь в программе Probe, выбрать 
пункт меню Trace > Add Trace. Появится окно, в левой части которого бу-
дет находиться список всех возможных выходных переменных, из которых 
можно выбрать необходимые. Также можно ввести список выводимых 
графиков через пробел вручную в поле в нижней части окна. 
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6. ПРИМЕР ПРОЕКТИРОВАНИЯ СХЕМЫ 

 
Рис. 11. Электрическая схема (компаратор 597СА1) 
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Рис. 12. Смоделированные характеристики 
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Рис. 13. Разводка схемы 
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